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OVERVIEW
ABOUT CONEQ™ TECHNOLOGY

Real Sound Lab’s CONEQ™ is a technology to measure and correct the acoustic power fre-
quency response (APFR) of electro-acoustic transducer devices, such as loudspeakers. With
CONEQ™ every loudspeaker sounds better – clear, natural, and without attenuations –
within its whole frequency range. Ǒe CONEQ™ technology is applied in two steps. First,
a precise measurement of how well the loudspeaker transmits energy at each frequency is
done, and a compensation filter is automatically produced. Second, the filter is applied to
the audio signal by any of the software or hardware tools supporting CONEQ™.

ABOUT THIS MANUAL

Ǒis manual allows to quickly start using the CONEQ™ Workshop application – the tool for
measuring and filter synthesis. For a full list of available features please see the CONEQ™
Workshop Reference Manual.

Ǒe screenshots in this manual are taken on the Windows operating system. Ǒe corre-
sponding screens on Mac OS will look similar.

SYSTEM REQUIREMENTS

CONEQ™measurement is doneby sending a series of test signals to a device-to-be-measured
(typically, a loudspeaker) and recording the output of the device (typically, using a mi-
crophone). Proper measurement is crucial to achieve the best possible results with the
CONEQ™ technology. Ǒat is why several points about the system set-up must be taken
into account before using CONEQ™ technology:

1. Ǒe sound card or audio interface (audio device) and, if necessary, drivers must be
properly installed and configured.

2. Anomnidirectionalmeasurementmicrophonewith flat frequency response curvemust
be used. An acceptable alternative is to use an omnidirectional microphone with a
known, electronically available individual frequency response curve in a format that
is compatible with CONEQ™ Workshop.

3. Ǒeaudio devicemust beworking properly andbe compatiblewith the CONEQ™Work-
shop application. Ǒe audio device must be capable of simultaneous (full duplex)
playback and recording, and both the audio device and the measurement micro-
phone, along with the connecting cables, must be in perfect working order.

4. Ǒe loop-back test should be performed as described below.

Failure to take the stepsmentioned abovewill increase the probability of incorrectmea-
surements, whichmay causeundeserveddisappointment about the achieved results, CONEQ™
Workshop software, or CONEQ™ technology in general.
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STEP 1: SET-UP
INSTALLING THE SOFTWARE

First, install the CONEQ™ Workshop software application package. CONEQ™Workshop runs
on a variety of Windows™ operating systems (Windows XP SP3 and newer) as well as the
latest updates of Mac OS X 10.5 and 10.6.

Run the CONEQ™ Workshop set-up program to do the installation. CONEQ™ Workshop
requires Microsoft .NET Framework 2.0 (on Windows) as well as the latest eLicenser Control
Center software. Ǒe CD version of the installation software will check for the presence of
needed components and install them if necessary.

Ǒe download version of the CONEQ™ installation software does not contain these com-
ponents and they must be downloaded separately:

Microsoft .NET Framework 2.0: http://www.microsoft.com/downloads/details.aspx?
FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5&displaylang=en

eLicenser Control Center: http://www.elicenser.net/en/latest_downloads.html

COPY-PROTECTION

CONEQ™Workshop is protected against illegal copying by the eLicenser USB device. Ǒe de-
vice was delivered together with the software. It is recommended to connect the eLicenser
USB device only after the installation.

Ǒe eLicenser device delivered with the Unlimited edition of CONEQ™Workshop is ready
to use right out of the box. Ǒe eLicensers of the Annual and Limited editions contain a
non-active time-limited license. It must be activated to start the countdown and enable
use of the software.

To activate a time-limited license, connect the eLicenser and open the eLicenser Con-
trol Center application (on Windows use “Start -> All Programs -> eLicenser -> eLicenser
Control Center” , on Mac locate the eLicenser Control Center in the Applications folder). Ǒe
connected eLicensers will appear on the list. Select the CONEQ™Workshop Annual/Limited
license and choose “Actions -> Start License Usage Period” from the menu (see figure
1). Follow the instructions and after successfully completing the activation process, the
CONEQ™ Workshop software is ready to run.

Ǒeactivation process requires an Internet connection. If the computerwhere theCONEQ™
Workshop is to be used is not on-line, then activation can be done on any other computer
after installing the eLicenser Control Center application there. Ǒe latest version of the eLi-
censer Control Center application can be downloaded from http://www.elicenser.net/en/
latest_downloads.html

SETTING UP AUDIO PLAYBACK/RECORDING HARDWARE

CONEQ™Workshopneeds properlyworking audio hardware tomake correctmeasurements.
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Figure 1: Activation of the time-limited license for CONEQ™ Workshop Annual/Limited.

No equalizers and other sound enforcement

If the audio device or mixer has equalizer or other sound enforcement/improvement func-
tionality, it shall be bypassed or the equalizer pattern set to flat.

No input monitoring on the output

Ǒe input of the audio device shall not be routed by the device’s mixer to that device’s out-
put (i.e. you should not be able to hear your voice on the speakers when you speak into
the microphone). Otherwise, CONEQ™ will be recording multiple copies of more and more
distorted test signal, producing erroneous results.

Loopback test

To check the I/O interface of the audio device, we recommend to perform a test measure-
ment by setting up an analogue measurement loop.

To set up the loop, connect the output of the audio device back to its input using the
appropriate cable (not included).

IMPORTANT! It is very important to switch off phantom power during loopback measurement BE-
FORE connecting the input to the output because feeding 48V current to the output of the audio
interface will most likely damage the device irreparably.

IMPORTANT! Be careful to set the input and output levels so as to avoid clipping or even damaging
the equipment.

To execute the test measurement, perform STEPS 2 and 3 as described below. If the
measured APFR curve is flat as in figure 2 and there is just one narrow spike in the beginning
of the impulse response graph as in figure 3 then the audio device is adequate for CONEQ™
measurements.

If any deviation (e.g. as in figures 4 and 5) is observed then the sound path must be
checked for sources of distortion. Such causes can be resampling in operating system
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Figure 2: A correct loopback frequency response graph for the range 20-22500 Hz.

Figure 3: A correct loopback impulse response graph.

drivers or hardware, active limiters or clipping due to too high signal level, feedback, ac-
tive equalizer, broken cable, and many other causes.
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Figure 4: Loopback frequency response graph showing irregularities that suggest problemswith the set-up (in this case,
96kHz signal sample rate was resampled by Windows to 48kHz).

Figure 5: Loopback impulse response graph showing irregularities with the set-up (in this case, clipping happened due
to too loud input signal).

CONNECTING THE DEVICE UNDER TEST

Connect the DUT (Device Under Test) to the output of the audio device. Ǒe DUT might be
a loudspeaker or loudspeaker array, a signal processor, or a chain of devices that together
make up a sound system.

Ǒe typical use of CONEQ™Workshop is to measure a loudspeaker or loudspeaker array.
Ǒis scenario is assumed everywhere in this guide, unless specified explicitly. In this case
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connect the measurement microphone to the input of the audio device.
CONEQ™ Workshop can be used to measure the frequency response characteristics of

any chain of devices. In this case connect the output of the chain to the input of the au-
dio device. Be careful to match the signal levels as improper connections may irreparably
damage the audio devices.

At the end of STEP 1 the audio hardware is ready for use with CONEQ™ Workshop.
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STEP 2: CREATING A NEW PROJECT

Follow these steps to start working with a project:

1. Connect the eLicenser USB device to the computer;

2. Start CONEQ™ Workshop;

3. Choose “Project -> New” from the menu.

4. Choose a path where the project will be saved and give the project a name.

Figure 6: Main application window with a new project just created.

At the end of STEP 2, a new project window is open and the first measurement can be
made.
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STEP 3: MAKING A MEASUREMENT

Click on the “New...” button, located below the “Measurements” list in the project win-
dow. A “New measurement” window as in figure 7 will open.

Figure 7: Ǒe new measurement window.

CHOOSING PLAYBACK AND RECORDING DEVICES

Select the desired playback and recording devices from the appropriate lists.
Select the playback channel to which the test signal should be sent and the recording

channel where the microphone is connected.
Ǒe device lists will include a computer’s internal sound card (if applicable) and other

audio devices which are recognized by the system. Ǒe lists are updated continuously and
will reflect any changes to the list of available devices in real-time.

SETTING MEASUREMENT PARAMETERS

Type in themeasurement name (e.g. “Left_1” ). Measurement cannot be recordedwithout
giving it a name.

Choose the test signal period. Ǒe default period of 0.341 seconds is suitable for small
to medium size rooms. Longer sweep periods are required for larger and very reverberant
or very noisy venues, or when measuring low frequency drivers (subwoofers).

Select the recording sample rate which is supported by the audio device. 96 kHz is pre-
ferred to obtain a more precise measurement in the high frequency area.

Choose the way the measurement will stop. It is possible to end the measurement au-
tomatically after either a fixed time has elapsed or after a certain number of test signals are
produced. Manual method allows to stop measurement by pressing the “Stop Measure-
ment” button.
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SETTING UP GAIN

IMPORTANT! Make sure that all gain control(s) for the DUT (Device Under Test) are sharply attenu-
ated or OFF.Ǒe DUT is about to be stressedwith the CONEQ™ test signal. If the DUT is a loudspeaker,
overdrive could cause damage!

CONEQ™ Workshop provides a control for the output signal level. By default it is set to
-30dBFS to prevent very high output signal levels. However, this control is purely digital
and affects the resolution of the test signal. Ǒerefore, if the used sound output devices
(e.g. audio interfaces, amplifiers) have their own hardware level controls then use them to
attenuate the output signal and set the slider in CONEQ™ Workshop to the maximum level.

Click the “Start Test Signal” button to start playing the test signal on the selected play-
back device and channel. Slowly increase the output level of the system until the test sig-
nal can be heard. Ǒe CONEQ™ test signal is a rapidly swept sine-wave (sometimes called
”sweep”); once you hear it, you will unmistakably recognize it in the future.

Adjust the loudness to a comfortable listening level where you would be able to clearly
hear anyone speaking at the same time. A higher level is generally preferred, as it results in
a better signal-to-noise ratio. Be careful, however, not to drive the amplifier(s) into clipping
or overdrive the loudspeaker(s). If a loudspeaker is driven into distortion, themeasurement
will be skewed and loudspeaker damage could occur.

If the environment is noisy with other people present (such as stage lighting or con-
struction crews), it’s important to establish a level that is higher than the ambient noise.

Adjust the input gain by using the input gain control on the device, using the meter
in CONEQ™ Workshop as a guide. Ǒe CONEQ™ Workshop level meter (a horizontal bar just
below the lists of devices) should stay predominantly between the recommendedminimum
andmaximum levelmarks (”>” and ”<”, respectively) and never fill completely because that
means signal clipping (overload).

PERFORMING THE MEASUREMENT
Starting and stopping

While the test signal is playing, click “Start measurement” to start recording a measure-
ment (the name of the button will change to “Stop measurement” ). Ǒe measurement
timer will start displaying the elapsed time and the test signal counter will increase as the
measurement progresses.

Ǒe measurement will stop either automatically according to specified criteria or when
the “Stop measurement” button is pressed.

If you need some time to get to the measurement position, enter the amount of time in
the “Wait seconds before starting measurement” field. Ǒis is the time CONEQ™Workshop
will ignore from the start of the recorded measurement. Ǒe same amount of time will be
discarded from the end of the measurement (only in the manual stop mode) to allow you
to get back to the computer and stop the measurement without affecting the results.

CONEQ™ Workshop Acoustic Power Frequency Response Measurement and Correction System Quickstart Guide for v3.1.0
10

www.realsoundlab.com



Duration

Whenmeasuring a loudspeaker system, the basic principle of CONEQ™ is to acquire several
hundred measurement points around the loudspeaker system, thereby gathering enough
information to calculate the loudspeaker’s true Acoustic Power Frequency Response (APFR).
A minimum of 150 measurement points is recommended. Once 250 measurement points
are acquired, there is only a small advantage in acquiring more. Each test signal results
in one measurement point. Using the default test signal period of 0.341 ms, about three
measurement points per second are recorded. Recording 200 measurement points takes
slightly more than a minute.

In the case of measuring a sound card or other electronic signal processor, only 10 - 15
test signals need to be recorded in order to obtain a valid measurement.

Coverage area

To do a proper measurement it is useful to know the manufacturer’s specification of the
loudspeaker’s intended angle of coverage. For example, if the loudspeaker is specified as
a 90 x 40 degree device, you have to replicate that angle of coverage within the room. In
many situations, placing some marking tape on the floor can be a useful guideline.

When themeasurement is started,move themeasurementmicrophone slowly andevenly
throughout the angle of coverage of the loudspeaker system, working from top to bottom
and from left to right, for approximately 200 test signals (about 68 seconds when using
the default test signal period). An example of a measurement surface and the microphone
traverse path in front of a loudspeaker is shown in the figure 8.

Figure 8: Measurement surface and microphone traverse path in front of a loudspeaker.
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Distance

As a rule of thumb, measurement is taken at a similar distance from the loudspeaker, as
the size of the loudspeaker cabinet plus the distance from the loudspeaker to the nearest
reflective surface. Typically this will be no less than one metre and not more than five to six
metres.

Measuring too close will result in measuring each individual driver of the loudspeaker
which is not desired as we look at the loudspeaker cabinet as a system.

Measuring too far might gather too much of the room reflections which is useful infor-
mation but should not be used to automatically generate speaker correction filters.

Interpreting results

Whenmeasurement stops, CONEQ™Workshop calculates the acoustic power frequency re-
sponse and the first CONEQ™ correction filter for this measurement. When ready, the graph
showing the frequency response curve of the DUT will appear. See the figure 9 for a typical
example.

Figure 9: An example of the frequency response graph.

Ǒe green curve shows the actual measured acoustic power frequency response (APFR)
of the DUT, the yellow curve shows the correction filter, and the orange curve shows the
expected frequency response of the DUT after the filter is applied to the signal path. Ǒe
greyed-out areas enclose the automatically determined correction range.

An important other curve is the cyan curve labelled “Noise/Distortion” (see figure 10).
It shows the level of noise in the environment. It must be more than 10 dB below the APFR
curve at all frequencies within the correction range. If it is not, then a new measurement
should be taken by increasing the volume of the test signal, the sensitivity of the micro-
phone, or reducing the ambient noise level.

Check the impulse response graph to see if there are no errors e.g. due to non-linearities
(clipping, overdrive). An example of a typical impulse response graph is shown in figure 11.

CONEQ™ Workshop Acoustic Power Frequency Response Measurement and Correction System Quickstart Guide for v3.1.0
12

www.realsoundlab.com



Figure 10: Ǒe noise/distortion curve that is comfortably lower than the suggested 10 dB below the APFR.

Figure 11: A typical impulse response graph.

CHANGING FILTER PARAMETERS

Filter parameters can be changed in the top right area of the project window. Click the
“Recalculate Filter” button to create a new filter with modified parameters. Alternatively,
choose “Filter->Apply Changes” from the menu to update the currently selected filter.

Twomost important filter parameters are its resolution and sample rate. Ǒis determines
how precise the filter will be as well as where it can be used.

Choose “For APEQ™ hardware equalizer” to create a filter with 4096 taps and 48kHz
sample rate that can be used by the APEQ™ hardware equalizer.

Chooseoneof the plug-in options ( “For CONEQ™P2pro/P8pro plug-in” or “For CONEQ™
P2/P8plug-in” ) to create a filterwith 4096/1024 taps and one of the available sample rates
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that can be used by the CONEQ™ plug-ins inside a DAW (Digital Audio Workstation) or other
host applications, such as Cubase, Nuendo, Pro Tools, Sonar, Audition etc.

IMPORTANT! Ǒe sample rate of the filter must match the sample rate of the master track to which
the plug-in will be applied. To create a filter for the needed sample rate, choose the sample rate
from the “Sampling frequency” list and click the “Recalculate Filter” button.

IMPORTANT! Loudspeakers for each channel must be measured separately. Repeat the STEP 3 for
the other channels that are to be corrected.

Now, we are ready to use the generated correction filters with compatible hardware or
software tools that support the “FIR” filter file format.
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STEP 4: APPLYING THE CONEQ™ CORRECTION FILTERS

Either the APEQ™hardware equalizer or the CONEQ™software plug-ins can be used to apply
the CONEQ™correction filter to the sound path. To do so, the CONEQ™correction filtermust
be saved as a “.FIR” file. ”FIR” stands for Finite Impulse Response and is the filter format
used by all CONEQ™-compatible software and hardware tools.

If using the APEQ™ hardware equalizer, the currently selected filter can be uploaded to
it directly from CONEQ™ Workshop by using the APEQ™ control panel on the main window
(see figure 12) without having to access the “.FIR” file directly.

Figure 12: APEQ™ control panel on the main window.

Ǒe CONEQ™ Workshop saves the “.FIR” files to a folder inside the project folder struc-
ture. A convenient way to access the filter file is to click on the filter in the Measurement list
and select “Filter -> Open Filter Folder” from the menu. Ǒe file with the extension “.FIR”
is the filter file.

Here is how to locate the relevant files manually. Let’s assume the project folder is
named “MySpeakers” . Let’s also assume that two measurements were made, named
“Left_1” and “Right_1” for the left and right channels respectively. At last, let’s assume
that for the left channel one new filter was created after changing some parameters and
this is the filter we are looking for. Ǒe project will have the folder structure as shown in
figure 13. Ǒe selected file “MySpeakers_1_Left_1_02.fir” is the filter file we are seeking.

Figure 13: Ǒe project folder structure and filter file location.

Ǒere are two folders for the Left_1 measurement. Ǒe folder “01” contains the first
filter data, calculated directly after the measurement was taken. Ǒe folder “02” contains
the filter created after the change of some parameters.

Ǒe filter for the right channel is located in folder “MySpeakers/002_Right_1/01” and
is named “MySpeakers_2_Right_1_01.fir” .
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USING APEQ HARDWARE EQUALIZER

APEQ is a family of Real Sound Lab’s hardware equalizers that apply CONEQ™ correction
filters to audio signal. Typically, the filters are uploaded to the device either from within
CONEQ™Workshop using the APEQ™control panel or using the APEQ™ Communication Tool
(C2) software that is bundled with every APEQ™ unit. Ǒe C2 tool has a User Guide that
describes how to use it in more detail.

Figure 14: Ǒe APEQ-2pro two-channel hardware equalizer.

IMPORTANT! For use with the APEQ™ hardware, create and save filter files that have 4096 taps at
48kHz. Filter fileswith other settings are not recognized by the APEQ™hardware equalizer. CONEQ™
Workshop provides a dedicated setting for filter parameters, designed for APEQ™ hardware equal-
izer.

Ǒe APEQ™ units are true multi-mono equalisers and each channel can be used for any
purpose independent of the other channels. For instance, the two channels of a two chan-
nel APEQ™ unit can be the left and right channels or they can be the centre and subwoofer
channels or any other channels as needed. Each channel uses a dedicated CONEQ™ cor-
rection filter.

USING CONEQ™ PLUG-INS

Real Sound Lab offers CONEQ™ plug-ins for use with DAW (Digital Audio Workstation) ap-
plications. Currently, VST and RTAS host applications (Cubase, Nuendo, Sonar, Pro Tools,
Audition, etc.) are supported. Ǒe AudioUnit (Apple Logic etc.) versions are being devel-
oped.

Ǒe filter sampling frequencymustmatch the sampling frequency of the stream (master
track) to which the plug-in is applied. E.g. to work on a 48kHz audio data, a 48kHz filter file
must be created by choosing the corresponding value in the “Sampling frequency field” .
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Figure 15: Ǒe user interface of the CONEQ™ P8pro plug-in.

IMPORTANT! For use with the CONEQ™ P8/P2 plug-ins, create and save filter files that have
1024 taps. CONEQ™ Workshop provides a dedicated setting for filter parameters, designed for
CONEQ™ P2/P8 plug-ins. Ǒe 4096 tap filters are not supported by these plug-ins. For higher
resolution filters, use either the APEQ™ hardware unit or CONEQ™ P2pro/P8pro plug-ins.

IMPORTANT! Streams of different sampling frequencies require different FIR files. Ǒismeans that to
work on audio at 44.1kHz, 48kHz, and 96kHz, three separate filters must be saved for each channel.
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TECHNICAL SUPPORT

Please feel free to contact us at any time about any difficulties using CONEQ™ Workshop
software (our contact details are listed below). We will do our best to respond to you as
quickly as possible. Our mission is to make your experience with CONEQ™ as simple and
rewarding as possible. To help us resolve issues quickly, we might need one or more of the
following data:

1. CONEQ™ Workshop software edition and version (It can be found in “Help -> About”
).

2. Ǒe operating system: Windows XP, Windows Vista, or Windows 7, Mac OS X 10.5 or
10.6.

3. Computer information: CPU type and speed, installed memory.

4. Description of the problem (asmuch information for us to understand the problem as
possible, including screenshots and/or crash logs if relevant).

CONTACTING REAL SOUND LAB

Should you have questions or comments, please contact us using one of the followingways:

1. E-mail: support@realsoundlab.com

2. WWW: www.realsoundlab.com

3. Phone: +371 6788 9828 (Real Sound Lab SIA Headquarters, Riga, Latvia)

Ǒank you for choosing CONEQ™!
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APPENDIX
CREATING A COMPOSITE MEASUREMENT

Sometimes it is necessary to average several individual measurements. Such cases include
but are not limited to cases when we want to exclude any measurement error by repeating
the same measurement several times, or when making a single measurement of the full
measurement surface is not technically or physically possible.

In these cases use the measurement composition feature of CONEQ™ Workshop. Ǒe
following is a description of the basic operating procedure.

First, acquire the individual measurements that will make up the composite response.
After doing so, either click on the “Composite...” button just below the measurements list
or choose “Measurement -> Composite” from the menu.

A window similar to the one in figure 16 will open. Type in the name of the composite
measurement. Choose the measurements to use for the calculation of the composite by
checking the check boxes alongside the measurement names.

Click the “Calculate” button to calculate the composedmeasurement. After calculation
is done the composedmeasurement will appear on themeasurements list along with other
measurements.

Figure 16: Measurement composition window.
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CONEQ™ USER LICENSE AGREEMENT

CONEQ™ User License Agreement
IMPORTANT: Please read this License Agreement carefully. By installing and using all or

any portion of the CONEQ™software anddocumentation (Software) you accept all the terms
and conditions of this License Agreement.

Ǒis document is an agreement between you (an individual or a business) and Real Sound
Lab SIA and/or its affiliates (the specific reciprocal party to this agreement may be based on
where you reside). Your use of the Software indicates your acceptance of these terms.

You may have another written agreement directly with Real Sound Lab SIA that supple-
ments or supersedes all or portions of this License Agreement.

IF YOU DO NOT AGREE TO THESE TERMS AND CONDITIONS, YOU MAY RETURN INTACT AND
UNOPENED, THE SOFTWAREPACKAGE TOGETHERWITH THEOTHERCOMPONENTSOF THEPROD-
UCT, TO THE PLACE OF PURCHASE FOR A FULL REFUNDOF THE PURCHASE PRICE. IF YOU DONOT
ELECT TO RETURN THE SOFTWARE AND ITS RELATED COMPONENTS WITHIN 30 DAYS FORM THE
DATE OF YOUR RECEIPT OF SAME, YOU WILL BE DEEMED TO HAVE AGREED TO THIS LICENSE
AGREEMENT IN ITS ENTIRETY.

Real Sound Lab SIA owns all intellectual property in the Software. Ǒe Software is li-
censed, not sold.

Real Sound Lab SIA permits you to download, install, use or otherwise benefit from the
functionality or intellectual property of the Software only in accordance with the terms of
this License Agreement.

As used in this License Agreement, the term ”Software” means the software down-
loaded from the internet, or otherwise acquired, and/or included on the CD or portable
flash media provided with this License Agreement.

Ǒe Software is delivered with the eLicenser USB device that is designed to prevent
unauthorized use and copying and enforce license restrictions. Ǒe eLicenser protection
technologymay prevent your use of the Software if you do not follow the installation and/or
licensemanagement process described in the Software and documentation or if you use the
Software in a way not permitted by this License Agreement.

1. PROPRIETARY RIGHTS. Ǒe Software and any accompanying documentation are the
proprietary products of Real Sound Lab SIA and/or its licensors. Ǒe structure, organization
and code of the Software are the valuable trade secrets and confidential information of Real
Sound Lab SIA and/or its licensors. Ǒe Software and any accompanying documentation
are protected under national laws and international treaty provisions. Ownership of the
Software and all copies, modifications, translations, and merged portions thereof shall at
all times remain with Real Sound Lab SIA and/or its licensors. Ǒis License Agreement does
not grant you any intellectual property rights in the Software and all rights not expressly
granted are reserved by Real Sound Lab SIA and/or its licensors.

2. GRANT OF LICENSE. Ǒe Software and accompanying documentation are being li-
censed to you, which means you have the right to use the Software only in accordance
with this License Agreement. Ǒe Software is considered in use on a computer when it is
loaded into temporarymemory. Ǒis Licensemay not be assigned, or otherwise transferred,
without prior written consent from Real Sound Lab SIA, and any unauthorized transfer is
therefore null and void.
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Youmay install the Software on any number of computers but you are authorized to use
the Software only on one computer at any time.

Ǒe Software is licensed for your own personal use if you are an individual or for your
own internal business purposes if you are a business. Explicitly excluded from the license is
using CONEQ Software to derive correction filters for use in devices or software that are not
produced by Real Sound Lab SIA. For such use a separate license from Real Sound Lab SIA is
required.

BACKUP COPY. In addition to any copies authorized under this License Agreement, you
may make a single copy of the Software solely for backup purposes, provided your backup
copies are not installed or used for other than archival purposes.

UPDATES AND SUPPORT. You are entitled to receive technical support as outlined in the
Software documentation. You are entitled to receive Software updates (updates shall in-
clude any patches or bug fixes that Real Sound Lab SIA makes generally available at http:
//www.realsoundlab.com) in accordance with Real Sound Lab SIA policies as announced
from time to time on terms comparable to those offered to other users of the Software un-
der similar licenses. In order to receive Software updates, you must possess a valid license
to a previous version of the Software.

3. NON-PERMITTED USES. Any permitted copy of the Software that youmakemust con-
tain the same copyright and other proprietary notices that appear on or in the Software.

No Modifications. You may not modify, adapt or translate the Software. You may not
reverse engineer, decompile, disassemble or otherwise attempt to discover the source code
of the Software.

No Unbundling. Ǒe Software may include various applications, utilities and compo-
nents, may support multiple platforms and languages and may be provided to you on mul-
tiple media. Nonetheless, the Software is designed and provided to you as a single product
to be used as a single product on your computer. You are not required to use all component
parts of the Software, but you may not unbundle the component parts of the Software for
use on different computers. You may not unbundle or repackage the Software for distribu-
tion, transfer or resale.

No Transfer. YOU MAY NOT RENT, LEASE, SELL, SUBLICENSE, ASSIGN OR TRANSFER YOUR
RIGHTS IN THE SOFTWARE, OR AUTHORIZE ANY PORTION OF THE SOFTWARE TO BE COPIED ONTO
ANOTHER INDIVIDUALOR LEGAL ENTITY‘S COMPUTER. Youmay, however, permanently trans-
fer all your rights to use the Software to another individual or legal entity provided that: (a)
you also transfer (i) this License Agreement, (ii) the Software and all other software and/or
hardware bundled, packaged or pre-installed with the Software, including all copies, up-
grades, updates and prior versions, (iii) the eLicenser device; (b) you retain no upgrades,
updates or copies, including backups and copies stored on a computer; and (c) the receiv-
ing party accepts the terms and conditions of this License Agreement and any other terms
and conditions under which you purchased a valid license to the Software. Prior to a trans-
fer Real Sound Lab SIA may require that you and the receiving party confirm in writing your
compliancewith this License Agreement, provide Real Sound Lab SIAwith information about
yourselves, and register as end-users of the Software.

4. COMPLIANCE WITH LICENSES. If you are a business, company or organization, you
agree that upon request from Real Sound Lab SIA or its authorized representative you will
within 30 (thirty) days fully document and certify that use of any and all Software at the
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time of the request is in conformity with your valid licenses from Real Sound Lab SIA.
5. ONLINE SERVICES. Ǒe Software may rely upon or facilitate your access to websites

maintained by Real Sound Lab SIA or its affiliates or third parties offering goods, informa-
tion, software and services. Your access to and use of any website or online services is
governed by the terms, conditions, disclaimers and notices found on such site or other-
wise associated with such services. Real Sound Lab SIA may at any time, for any reason,
modify or discontinue the availability of any website or online services. Real Sound Lab SIA
does not control, endorse or accept responsibility for websites or online services offered by
third parties. Any dealings between you and any third party in connection with a website
or online services, including delivery of and payment for goods and services and any other
terms, conditions, warranties or representations associated with such dealings, are solely
between you and such third party.

6. DEFECT AND LOSS OF THE ELICENSER DEVICE In the case of a defect or damage to the
eLicenser, Real Sound Lab SIA or a third party engaged by Real Sound Lab SIA will check the
eLicenser. In the case of a legitimate claim the eLicenser and the licenses included shall
be replaced in return for a handling fee. Ǒe licenses will only be replaced provided that
they are licenses issued by Real Sound Lab SIA. Ǒe handling fee will not be charged if the
eLicenser fails within one year of the original purchase. Further claims against Real Sound
Lab SIA are excluded.

Real Sound Lab SIA assumes no liability or obligation if the eLicenser is mislaid as a result
of loss, theft or otherwise. Real Sound Lab SIA reserves the right to block the eLicenser
upon being notified by the user of the loss. Ǒe licenses saved on the eLicenser cannot be
replaced.

6. LIMITATION OF LIABILITY. In no event shall Real Sound Lab SIA liability related to any
of the Software exceed the license fees actually paid by you for the Software. Except for
a return of the purchase price under the circumstances provided under the Limited War-
ranty, neither Real Sound Lab SIA nor its suppliers shall, in any event, be liable for any loss,
damages, claims or costs whatsoever arising out of or related to, the use of, or inability to
use, the Software, including but not limited to direct, indirect, special, incidental, or con-
sequential damages, and damages for loss of business profits, business interruption, loss
of business information, or other pecuniary loss, even if Real Sound Lab SIA has been ad-
vised of the possibility of such damages, whether such liability is based on contract, tort,
warranty, or any other legal or equitable grounds. In the event that the territory that you
reside in does not allow the exclusion or limitation of liability for consequential or incidental
damages, the above limitation may not apply to you.

7. NO WAIVER. Any failure by either party to this agreement to enforce a specific part
of the agreement in a specific situation is not a waiver of rights under the agreement. Ǒe
party may still enforce the rest of the agreement in such a situation and may still enforce
some or all of the agreement in other situations.

8. Ǒis License Agreement constitutes the entire agreement between you and Real
Sound Lab SIA pertaining to its subject matter. Ǒis License Agreement is governed by the
laws of the State of California. Any litigation arising from this license will be pursued only in
courts of the State of California. Even if part of the agreement is held invalid, the rest of the
agreement is still valid, binding and enforceable.

Should you have any questions regarding this License Agreement, if you wish to request
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any information or to contact Real Sound Lab SIA for any reason, please use the address and
contact information provided below:

Real Sound Lab SIA
Akademijas laukums 1
Riga, LV-1050, Latvia
www.realsoundlab.com

Copyright 2004-2011 Real Sound Lab SIA. All rights reserved. Ǒe Software may be pro-
tected by U.S. and international patents. CONEQ™ is a registered trademark of Real Sound
Lab SIA.

All other product names, logos, brands, and other trademarks referred to within this
Agreement are the property of their respective trademark holders.
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TRADEMARKS

”CONEQ” and ”APEQ” are registered trademarks of Real Sound Lab SIA. ”RTAS” is a trade-
mark or a registered trademark of Avid Technology, Inc. or its subsidiaries in the United
States and/or other countries. ”VST” is a trademark and software of Steinberg Media Tech-
nologies GmbH. All other product or company names and trademarks are property of their
respective owners and are used solely for the purpose of identifying the specific products.
Use of the trademarks does not imply any cooperation or endorsement.
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